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Anotācija 
 

Mūsdienu  informācijas telpā aizvien svarīgāki kļūst digitāli laika un aktivitāšu plānotāji. 
Viedierīces, datori, pulksteņi un citi rīki(gadžeti) ir aprīkoti ar digitālām laika uzskaites un 
plānošanas programmām un sistēmām. Tomēr sabiedrībā vēl aizvien ir liels pieprasījums pēc 
tradicionāliem, drukātiem kalendāriem, kas veic gan funkcionālu, gan estētisku darbu, kalpojot 
kā zīmolu vēstneši vai vienkārši kā drukāti funkcionāli estētiski objekti telpas interjerā. 
 
Pieaugot tehnoloģiskām iespējām(druka notiek ātrāk, var drukāt mazāku eksemplāru skaitu, 
vidusslāņa cilvēkam iespējams finansiāli atļauties), gan uzņēmumi gan fiziskas personas bieži 
izvēlas izdot un nodrukāt savus, personalizētus kalendārus. 
 
Mācību līdzeklis paredzēts ikvienam interesentam, kuram ir pamatiemaņas darbā ar programmu 
Adobe InDesign, kā arī tiem, kas vēlas iegūt pamatiemaņas un izpratni par kalendāra maketa 
izveidi, izmantojot Adobe InDesign. 
Šis materiāls noderēs arī tehnikuma audzēkņiem, kas apgūst mākslas un dizaina specialitātes, 
gatavo grafikas dizaina darbus. Lai veiksmīgi strādātu ar šo materiālu, nepieciešamas labas 
datorprasmes, dators, uz kura instalēta biroja un grafikas dizaina programmatūra(Adobe 
InDesign), kā arī interneta pieslēgums, lai varētu strādāt ar materiālā pievienotajām saitēm. 
 
Ļoti ieteicamas arī angļu valodas zināšanas vismaz nelielā apjomā, jo daudz informācijas ir 
jāuztver un jāpielieto angļu valodā. Šobrīd informācija ļoti strauji mainās. Tādēļ, sekojot līdzi 
jaunākajam, aktuālākajām tendencēm un iespējām, darba paņēmieniem,  nākas lasīt un izmantot 
materiālus angļu valodā. 
 
Šajā materiālā 36 h apjomā, 6 tēmās un 12 apakštēmās strukturēti ir aprakstīta informācija, kas 
izmantojama, lai iegūtu zināšanas kalendāra maketa izveidei, izmantojot Adobe InDesign. 
Ievietoti 6 attēli un 9 tabulas, kas numurētas secīgi. 
 
Izmantota metodika – informācijas tehnoloģiju izmantošana, individuāls patstāvīgais darbs, 
jautāšana un atbildēšana, informācijas atrašana tīmeklī(grafikas dizaina industrijas profesionālās 
mājaslapas) vizualizēts stāstījums, pārrunāšana, diskusijas.  
 
Katra tēma ir apgūstama 6 mācību stundās, no kurām 4 paredzētas informācijas lasīšanai, 
skatīšanai, izpētei un analizēšanai, bet 2 plānotas praktiska uzdevuma veikšanai, lai pielietotu un 
izmēģinātu iegūtās zināšanas. Uzdevumi vērtējami summatīvi, atbilstoši Ogres tehnikumā 
apstiprinātajiem vērtēšanas noteikumiem. Katras tēmas noslēgumā pievienoti paškontroles 
jautājumi, lai nostiprinātu iegūtās iemaņas un izpratnes, kā arī uzdevums. 
 
Mācību līdzeklis balstīts uz klasiskām izpratnēm, personīgo pieredzi un resursiem (grāmatas, 
tīmeklis) darbā ar Adobe InDesign maketēšanas iespējām, kā arī uz aktuālu internacionālu 
dizaina speciālistu un dizaina blogeru redzējumu, secinājumiem un ieteikumiem. 
 
Katrai apakštēmai atlasītas un pievienotas saites, kas satur izvērstu skaidrojošu materiālu par 
apgūstamo tēmu.  
 
Izskatot un pārlasot norādīto informāciju, kā arī precīzi pa punktiem izpildot ieteiktos 
uzdevumus, kalendāra maketu izdosies kvalitatīvi izgatavot. 
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Mācību rezultāts vērtējams atbilstoši Ogres tehnikumā apstiprinātajiem vērtēšanas noteikumiem. 
 
Lai produktīvs un aizraujoši veiksmīgs darbs, veidojot kalendāra maketu Adobe InDesign!
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1.Kalendāra būtība un vēsturiskā evolūcija 

 

Tēmas apjoms 6 mācību stundas  

Mērķis Uzzināt par kalendāra kā funkcionāli estētiska objekta būtību un 
daudzveidību.  

Uzdevumi Iepazīties ar kalendāru veidiem kultūru un vēsturiskās evolūcijas 
kontekstā 

Sasniedzamais 
rezultāts 

Audzēknis spēj orientēties kalendāru uzbūves, stilu un tehnisko 
risinājumu daudzveidībā. Spēj atrast un izmantot iedvesmas piemērus. 

Zināšanas Zina kalendāru veidus, atpazīst tos.  

Prasmes Spēj izvēlēties darbam vajadzīgos kalendāru risinājumu veidus. 

 
 

 

Apakštēmas 
1.,2.,3.,4. mācību stunda 

 
1. Kalendārs dažādās kultūrās un laikos. 

Jau pirms mūsu ēras laika plūduma līnija tika uzskatāmi attēlota, izmantojot pieejamos 
materiālus un darbarīkus. Mūsdienu grafikas dizainers, pētot senās vēstures liecības, rod 
iedvesmu un idejas jaunām kombinācijām un risinājumiem, kurus iespējams realizēt, 
pateicoties modernajām tehnoloģijām – maketēšanas datorprogrammām un ražošanas 
iekārtām. 
 
 

 
 

1.attēls.  Kalendāra struktūras un kārtojuma fragments. Fasti Antiates Maiores. 60gadi pirms Kristus. 

 
Sākot strādāt pie kalendāra maketa projekta, iedvesmu var atrast pētot: 
1. Kalendāru un laika uzskaites veidus(grupējot vienības no mikro uz makro); 
2. Reliģisko kalendāru uzbūvi(rotācija ap svarīgu notikumu); 
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3. Austrumu kultūru kalendārus; 
4. Rietumu kultūru kalendārus vēsturiskos periodos; 
5. XX un XI gadsimta grafikas dizaineru radošos meklējumus. 

 
Lasāmā informācija. 
Tīmekļa enciklopēdija “Britannica” par kalendāra vēsturi un nozīmi - 
https://www.britannica.com/science/calendar 
 
Bloga raksts par kalendāra dizaina risinājumu attīstību – 
https://uxdesign.cc/a-brief-history-of-calendar-design-c3f876689fed 
 
 

2. Latviskajā kultūrā sakņots kalendāra risinājums 
Strādājot pie kalendāra maketa uzbūves skices, ieteicams ielūkoties un pētīt latviskās 
dzīvesziņas tradīcijās veidotu kalendāru risinājumus. 
 

 
 
2.attēls.  Latviskās dzīvesziņas gadskārtu kalendārs. Latvijas Dievturu sadraudzes materiāls. 

 

Lasāmā informācija.  
Latvijas Dievturu sadraudzes informācija par latviešu gadskārtu kalendāru – 

http://dievturi.blogspot.com/p/kalendars.html 

  

https://www.britannica.com/science/calendar
https://uxdesign.cc/a-brief-history-of-calendar-design-c3f876689fed
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Jautājumi paškontrolei: 
 

1. Kas ir kalendārs? 
 

2. Kāda ir kalendāra funkcija? 
 

3. Kāda ir kalendāra estētiskā un mārketinga nozīme? 
 

4. Kur smelties iedvesmu, sagatavojoties kalendāra maketa izveidei Adobe InDesign?  
 

5. Kāda nozīme, uzsākot maketa plānošanu, ir dažādu jau esošu piemēru izpētei? 
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Uzdevums 1 
 

5.,6. mācību stunda 
 
1. Atvērt ieteiktās tīmekļa saites. Iepazīties ar resursa saturu. 

 
2. Atlasīt mapē attēlus un informāciju, kas ieinteresējusi. (Vismaz 10 piemēri) 
 
3. Izvēlēties 2 piemērus, kas šķiet visnozīmīgākie un vērtīgākie. 
 
4. Noformulēt un salīdzināt risinājumu veidus. 
 
5. Uz A3 formāta skiču lapas veikt skices un piezīmes, kas varētu būt noderīgas, veidojot 

kalendāra maketu Adobe InDesign programmā. 
 

 
Vērtēšana. 
 

Katra paveiktā darbība, izpildot uzdevumu, maksimāli dod 20 procentus. Nepaveikta darbība – 0 
procentus. Kopā, izpildot uzdevumu, maksimāli iespējams iegūt 100 procentus. 
Iespējami 5 uzdevuma darbību izpildes līmeņi. 
 

0.līmenis 
0 procenti 

1.līmenis. 
5 procenti 

2.līmenis. 
10 procenti 

3.līmenis. 
15 procenti 

4.līmenis. 
20 procenti 

Darbība 
nav 
paveikta. 

Darbība 
daļēji/nepilnīgi 
paveikta. 

Darbība 
paveikta, tomēr 
ir 
neprecizitātes 

Darbība precīzi 
paveikta. 
Audzēknis 
demonstrē izpratni 
par paveikto 

Darbība precīzi paveikta. 
Audzēknis demonstrē 
izpratni par paveikto. 
Analizē un pamato 
veiktās darbības. Zina un 
izprot paveikto darbību 
nozīmi un jēgu 
profesionālajā darba 
vidē. 

 

1.tabula. Uzdevuma vērtēšanas kitēriji 

 
 
Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu skalā, 
atbilstoši summatīvā vērtējuma izteikšanas tabulai Nr.9. 
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2.Kalendāra maketa dizaina izveide 
 

Tēmas apjoms 6 mācību stundas  

Mērķis Apgūt kalendāra dizaina izveides principus. 

Uzdevumi Atpazīt un izvēlēties dizaina veidus, kas būtu pielietojami, maketējot 
kalendāru Adobe InDesign. 

Sasniedzamais 
rezultāts 

Spēja radīt kalendāra maketam un konceptam atbilstošu un pielietojamu 
dizainu. 

Zināšanas Zina dažādus dizaina risinājumu piemērus.  

Prasmes Spēj praktiski izvēlēties un prot radīt maketam atbilstošus dizaina 
risinājumus. 

 

 

 
Apakštēmas 

7.,8.,9.,10. mācību stunda 
 

1. Kalendāra grafikas dizaina iedvesmas avoti. Kopaina. Aktuālās tendences, vienojošās 
pazīmes. 
Maketa izveides procesu tieši nosaka iecerētais kalendāra grafikas dizains. Atrodot savu 
vēlamo un atbilstošāko risinājumu, svarīga nozīme ir piemēru aplūkošanai un analīzei. 
Bagātīgāko, vispusīgāko, jaunāko un aktuālāko informāciju visātrāk iespējams atrast un 
izmantot tīmeklī, kur arī novērojamas aktuālās tendences. 
Iedvesmas piemēru attēlus ieteicams iekopēt vienotā mapē. Svarīgi piefiksēt arī atsauci 
uz atrasto un izvēlēto piemēru. 

Jāņem vērā, ka uz lielāko attēlu daļu tīmeklī ir attiecināmas autortiesības. 
 

Veicot izpēti, svarīgi vienlīdzīgi pievērst uzmanību: 
1. Krāsu paletei; 

2. Kompozīcijai; 
3. Burtveidolu atlasei un lietojumam; 

4. Izmēram/formai; 
5. Materiāla izvēlei. 
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3.attēls.  Kalendāru grafikas dizaina risinājumu piemēri. https://dribbble.com/tags/calendar_2022 
 
Lasāmā informācija. Kalendāru dizainu piemēri. Forma un grafikas dizains -  
https://dribbble.com/tags/calendar_2021 
https://dribbble.com/tags/calendar_2022 
https://design-milk.com/16-modern-calendars-for-2020/ 
Grafikas dizaina tendences 2023 – 
https://www.creativebloq.com/features/graphic-design-trends 
 

2. Kalendāra grafikas dizaina ikonas – pasaules grafikas dizaina klasiķi: 
Strādājot pie maketa grafikas dizaina, noteikti jāielūkojas arī pāri laikam stāvošās 
vērtībās – risinājumos, kas “vienmēr būs modē” 
 

 
 
4.attēls.  Massimo Vignelli kalendārs.  
 
 

https://dribbble.com/tags/calendar_2021
https://dribbble.com/tags/calendar_2022
https://design-milk.com/16-modern-calendars-for-2020/
https://www.creativebloq.com/features/graphic-design-trends


    Page  of 31 
 

Kalendāra maketa izveide, izmantojot Adobe InDesign  
 

 

 

12 

 
Lasāmā/Skatāmā informācija. Pasaules grafikas dizaina klasiķu risinājumi - 
https://eu.stendigcalendars.com/?utm_source=google.com&utm_medium=organic 
 
  

Jautājumi paškontrolei: 
 

1. Veicot kalendāra grafikas dizaina risinājumu izpēti, kādiem punktiem jāpievērš 
uzmanība? 
 

2. Vai jāizskata tikai pēdējā laika grafikas dizaina risinājumu piemēri? 
 
3. Kā jāsaglabā informācija(atlasītie piemēri)? 

 
4. Vai jāsaglabā atsauce, kur atrasti attēli? 

 
5. Vai jāievēro autortiesības attiecībā uz dažādu grafikas dizaina risinājumu piemēriem? 

 
  

https://eu.stendigcalendars.com/?utm_source=google.com&utm_medium=organic
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Uzdevums 2 
 

11.,12. mācību stunda 
 
1. Atrodam tīmeklī vismaz 10 iedvesmojošus kalendāra grafikas dizaina piemērus. 

 
2. Apkopojam materiālu mapē(digitāli). 

 
3. Uzrakstām uz lapas vismaz 5 punktus, kādus principus no atlasītā materiāla izmantosim 

savā kalendāra risinājumā. 
 

 
 

Vērtēšana. 
 

Katra paveiktā darbība, izpildot uzdevumu, maksimāli dod 20 procentus. Nepaveikta darbība – 0 
procentus. Kopā, izpildot uzdevumu, maksimāli iespējams iegūt 100 procentus. 
Iespējami 5 uzdevuma darbību izpildes līmeņi. 
 

0.līmenis 
0 procenti 

1.līmenis. 
5 procenti 

2.līmenis. 
10 procenti 

3.līmenis. 
15 procenti 

4.līmenis. 
20 procenti 

Darbība 
nav 
paveikta. 

Darbība 
daļēji/nepilnīgi 
paveikta. 

Darbība 
paveikta, tomēr 
ir 
neprecizitātes 

Darbība precīzi 
paveikta. 
Audzēknis 
demonstrē izpratni 
par paveikto 

Darbība precīzi paveikta. 
Audzēknis demonstrē 
izpratni par paveikto. 
Analizē un pamato 
veiktās darbības. Zina un 
izprot paveikto darbību 
nozīmi un jēgu 
profesionālajā darba 
vidē. 

 

2.tabula. Uzdevuma vērtēšanas kitēriji 

 
 
Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu skalā, 
atbilstoši summatīvā vērtējuma izteikšanas tabulai Nr.9. 
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3.Kalendāra maketa izveidē izmantojamā informācija un saturs. 
 

Tēmas apjoms 6 mācību stundas  

Mērķis Atbilstošas  un korektas informācijas izmantošana, veidojot kalendāra 
maketa saturu. 

Uzdevumi Atrast informāciju par datumiem, vārda dienām, svinamām un 
atzīmējamām dienām.  

Sasniedzamais 
rezultāts 

Korektas saturiskas informācijas izmantošana kalendāra maketā. 

Zināšanas Zina svarīgākos informācijas avotus.  

Prasmes Prot atrast un izmantot informāciju satura veidošanai kalendāra maketā. 

 
 

 

Apakštēmas 
13.,14.,15.,16. mācību stunda 

 
1. Datumi, nedēļas dienas, Mēnes fāzes, svinamas un atzīmējamas dienas un cita 

informācija. 
Funkcionālā kalendāra maketā saturiskajai informācijai ir jābūt korektai. 
Lai to nodrošinātu, jāizmanto korekti avoti. 
 

 
  
5.attēls. Viena no informācijas ieguves vietnēm tīmeklī.   
 
 
Lasāmā informācija. 
Vietnes datumu un citas svarīgas informācijas precizēšanai(starptautiskas svinamās 
dienas, Latvijā svinamas un atzīmējamas dienas u.c.): 
https://www.timeanddate.com/ 
https://kalendārs.lv/ 

https://www.timeanddate.com/
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2. Informācija par vārda dienām. 
Latvijā ir tradīcija atzīmēt vārda dienas. Lai informācija būtu pareiza un atbilstoša valstī 
noteiktajai, jāizmanto Latviešu tradicionālais un paplašinātais kalendārvārdu saraksts. 
 
Lasāmā informācija. 
Latviešu tradicionālais un paplašinātais kalendārvārdu saraksts: 
https://www.vvc.gov.lv/lv/jaunums/latviesu-tradicionalais-un-paplasinatais-
kalendarvardu-saraksts-pieejams-csv-atverto-datu-formata 
 
 
Jautājumi paškontrolei: 
 

1. Kur atradīsim informāciju par svinamām dienām ārpus Latvijas? 
 

2. Kā atradīsim informāciju(datumi un nedēļas dienas) 2058.gadam? 
 
3. Kur atradīsim valsts oficiālo/apstiprināto vārda dienu sarakstu? 
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Uzdevums 3 
 

17.,18. mācību stunda 
 
1. Atrast un lejuplādēt informāciju par 2024. gada datumiem, nedēļas dienām un Mēnes 

fāzēm. 
 

2. Atrast un lejuplādēt failu ar vārda dienu sarakstu. 
 

3. Atrast un iekopēt word dokumentā informāciju par svinamām un piemiņas dienām 2024. 
gada maija mēnesim. 
 

 
Vērtēšana. 
 

Katra paveiktā darbība, izpildot uzdevumu, maksimāli dod 20 procentus. Nepaveikta darbība – 0 
procentus. Kopā, izpildot uzdevumu, maksimāli iespējams iegūt 100 procentus. 
Iespējami 5 uzdevuma darbību izpildes līmeņi. 
 

0.līmenis 
0 procenti 

1.līmenis. 
5 procenti 

2.līmenis. 
10 procenti 

3.līmenis. 
15 procenti 

4.līmenis. 
20 procenti 

Darbība 
nav 
paveikta. 

Darbība 
daļēji/nepilnīgi 
paveikta. 

Darbība 
paveikta, tomēr 
ir 
neprecizitātes 

Darbība precīzi 
paveikta. 
Audzēknis 
demonstrē izpratni 
par paveikto 

Darbība precīzi paveikta. 
Audzēknis demonstrē 
izpratni par paveikto. 
Analizē un pamato 
veiktās darbības. Zina un 
izprot paveikto darbību 
nozīmi un jēgu 
profesionālajā darba 
vidē. 

 

3.tabula. Uzdevuma vērtēšanas kitēriji 

 
 
Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu skalā, 
atbilstoši summatīvā vērtējuma izteikšanas tabulai Nr.9. 
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4.Kalendāra maketa izveide manuāli, izmantojot saistītas teksta kastes un 
slāņus.  

 

Tēmas apjoms 6 mācību stundas  

Mērķis Apgūt paņēmienu kopumu kalendāra maketa manuālai izveidei. 

Uzdevumi Veikt secīgas darbības un Adobe InDesign komandas kalendāra izveidei.  

Sasniedzamais 
rezultāts 

Kalendāra maketa izveide. 

Zināšanas Zina Adobe InDesign komandas kalendāra maketa izveidei.  

Prasmes Praktiski pielieto Adobe InDesign komandas un paletes kalendāra maketa 
izveidē. 

 
 

 
Apakštēmas 

19.,20.,21.,22. mācību stunda 

 
1. Kalendāra grafiskais dizains tiek risināts atbilstoši dizaina iecerei. 

Kopējais darba lapas izmērs, forma, lapu secība, krāsu palete un burtveidolu izvēle ir 
dizaina ieceres noteikta. Kalendāra funkcionālā daļa tiek maketēta tam atvēlētajā zonā. 

 
2. Kalendāra funkcionālo daļu maketē, secīgi izmantojot zemāk minētās komandas un 

paletes. 
• Visus elementus salikumā sagrupē un kārto pa slāņiem, slāņus nosauc atbilstoši 

saturam; 
• Izveido un pielieto rindkopu stilus visiem tekstiem, kas tiek maketā izmantoti; 
• Datumu, vārda dienu un citu informāciju izkārto pa savstarpēji saistītām teksta 

kastēm, slāņos vienu virs otra; 
• Pa teksta kastēm informācija uz nākošo kasti tiek pārvietota ar taustiņu ENTER, 

(fn+RETURN ir alternatīva uz klaviatūrām, kur nav ENTER taustiņa), 
bet atpakaļ ar delete vai back. Skatīt 6. attēlu. 

• Ērtības un maketa kontroles labad ieteicams strādāt ar ieslēgtu -Type>Show 
Hidden Characters un View>Extras>Show Text Threads. Skatīt 7. attēlu. 
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6.attēls.  Kalendāra lapas maketa atvērums, paletes un komandas. 
 
 
 

 
 
 
 
 
 
7.attēls.  Kalendāra lapas maketa atvērums, paletes un komandas. 
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Jautājumi paškontrolei: 
 

1. Kāda ir taustiņu kombinācija, lai pārvietotu informāciju pa saistītām teksta kastēm 
kalendāra funkcionālās daļas maketā? 

 
2. Vai tekstam jādefinē rindkopu stili? 

 
3. Kādēļ jāieslēdz Type>Show Hidden Characters un View>Extras>Show Text Threads? 
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Uzdevums 4 
 

23.,24. mācību stunda 
 

1. Izveidot viena mēneša atvēruma salikuma lapu un tajā funkcionālās daļas informācijas 
režģi, izmantojot saistītās teksta kastes. 

 
2. Izveidotajās teksta kastēs izvietot datumu informāciju un atsevišķā slānī vārda dienu 

informāciju. 
 

3. Noformēt tekstus un kopējo kalendāra lapu atbilstoši iecerētajam dizainam. 
 
 

 
Vērtēšana. 
 

Katra paveiktā darbība, izpildot uzdevumu, maksimāli dod 20 procentus. Nepaveikta darbība – 0 
procentus. Kopā, izpildot uzdevumu, maksimāli iespējams iegūt 100 procentus. 
Iespējami 5 uzdevuma darbību izpildes līmeņi. 
 

0.līmenis 
0 procenti 

1.līmenis. 
5 procenti 

2.līmenis. 
10 procenti 

3.līmenis. 
15 procenti 

4.līmenis. 
20 procenti 

Darbība 
nav 
paveikta. 

Darbība 
daļēji/nepilnīgi 
paveikta. 

Darbība 
paveikta, tomēr 
ir 
neprecizitātes 

Darbība precīzi 
paveikta. 
Audzēknis 
demonstrē izpratni 
par paveikto 

Darbība precīzi paveikta. 
Audzēknis demonstrē 
izpratni par paveikto. 
Analizē un pamato 
veiktās darbības. Zina un 
izprot paveikto darbību 
nozīmi un jēgu 
profesionālajā darba 
vidē. 

 

4.tabula. Uzdevuma vērtēšanas kitēriji 

 
 
Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu skalā, 
atbilstoši summatīvā vērtējuma izteikšanas tabulai Nr.9. 
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5.Kalendāra maketa izveidē ieteicamo darbību secīgs kopums. 

 

Tēmas apjoms 6 mācību stundas  

Mērķis Apgūt kalendāra maketa izveidē lietojamo komandu secību. 

Uzdevumi Izveidot kalendāra vairāklapu salikumu, maketēšanas laikā pielietojot 
norādītās komandas.  

Sasniedzamais 
rezultāts 

Spēja apzināti izmantot maketēšanas laikā nepieciešamās Adobe 
InDesign komandas.  

Zināšanas Adobe InDesign komandu secība un jēga.  

Prasmes Praktiski pielieto Adobe InDesign komandas un paletes kalendāra maketa 
izveidē.  

 
 
 

Apakštēmas 
25.,26.,27.,28. mācību stunda 

 
1. Komandu secīgs apraksts. 

 
Lapas formāts, jauna dokumenta izveidošana (bez Facing Pages un Primary Text Frame!) 
 
Ja ir skaidrs, vai katrs mēnesis būs savā lapā, vai divi mēneši uz vienas lapas(katrs savā 
lapas pusē) var norādīt uzreiz arī lapu kopējo skaitu, kad tiek startēts dokuments. Piem. 
12 mēneši +1 vāka lapa, +1 aizmugures vāka lapa. Kopā 14 lapas dzīvē = 28 lapaspuses 
ID dokumentā. Ja uz vienas lapas 2 mēneši(katrs savā lapas pusē, tad vajadzēs 7 lapas 
dzīvē=14 lapas puses ID salikumā Pages panelī 
 
Parent lapa. Ieplānojam vietu datumiem un bildēm. Var sadalīt ar palīglīnijām. Ja 2 
vienādās daļās, tad Layout - Create Guides. Piem., ja atkāpe no lapas malām ir 10mm, 
tad var dalīt 2 kolonnās, kurām pa vidu Gutter - 10mm 
Vai arī dalīt kompozīcijas laukumos, izmantojot taisnstūru zīmēšanas veidu- velkam 
taisnstūri, neatlaižot pelīti, lietojam bultiņas uz klaviatūras(uz augšu-leju, pa labi-pa 
kreisi) 
 
Uzzīmējam rāmi bildei un teksta rāmīšus datumiem. Bildes rāmim jau laicīgi jānorāda 
Fitting Options (parasti - Fill Frame Proportionally) 
Ja nepieciešams, atsevišķi paredzam vietas dienu nosaukumiem, nedēļu numuriem, 
svinamo un atceres dienu zonai kompozīcijā.  
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Parent lapā importējam tekstu. Ja tas ir napieciešams, tad ar Ctrl+B (Command+B) 
iecentrējam vertikāli. 
 
Var sakopēt lapas(ja nav norādīts jau startējot dokumentu), bet pagaidām datumus 
nelabot, lai stilu varētu pievienot visām lapām uzreiz! 
 
Izveidojam teksta noformējuma paraugu un saglabājam to kā stilu tekstam (Paragraph 
Style). Stilu ieteicams izveidot Master Lapā, pirms lapās teksts vēl nav atslēgts. Ja 
nepieciešams, Master lapā izveidojam stilu teksta rāmīšiem (Object Style).  
 
Atslēdzam teksta laukus ar Ctrl+Shift (Command+Shift). Vai arī atslēdzam visu saturu 
lapās, kas ienācis caur Master(Overraid Parent items). Sakārtojam datumus. Bīdīt uz 
priekšu ar Enter (uz NumPad) vai Fn+Enter vai (Fn+Return) uz Apple datoru 
saīsinātajām un MAC book PRO klaviatūrām. Bīdīt atpakaļ ar Backspace. 
 
 
Ctrl+D (Command+D). Iezīmējam visas vajadzīgās bildes. Saliekam pa vietām. Vai arī 
ievietojam katru individuāli lapas bildei paredzētajā vietā. Ja bilžu zona sastāv no daudz 
bildēm vienotā kompozīcijā, tad ievelkam visas uzreiz un sasēdinām pa paredzētajām 
kastēm, vau arī zīmējam jaunas kastes, samētājot bildes/attēlus. Ja bildes nav pareizā 
secībā, tās pirms importēšanas var izvēlēties ar bultiņām uz klaviatūras. Liekās bildes var 
nodzēst, nospiežot Esc taustiņu. 
 
Pārejam uz Parent lapu. Nodublējam iepriekšējo slāni. Aizslēdzam to un izslēdzam acs 
simbolu. Jaunajā slānī ar Ctrl+A (Command+A) iezīmējam un nodzēšam visu tekstu. 
Importējam vārda dienas. Ar Ctrl+B (Command+B) novietojam pie apakšējās malas. 
Ieslēdzam acs simbolu pie datuma slāņa. Slāņiem piešķiram atbilstošus, saturu 
identificējošus nosaukumus) 
 
Veidojam papildus slāņus - piem. mēneša nosaukumiem, svētku dienām, mēness 
kalendāram utt....  
Ja tas ir nepieciešams, slāņus var mainīt vietām. Pabeigtos slāņus var aizslēgt.  
 

2. Maketa izveide, ja neizmanto Parent lapas. Ja nevēlas izmantot Parent lapas, Izveido 
salikumu pirmajai lapai(piem. janvāra mēnesim). Tad sagatavoto lapu duplicē, veic 
informācijas korekcijas atbilstošajam mēnesim, tad atkal duplicē. Tā rīkojas ļīdz visi 12 
mēneši sadizainēti.  
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Jautājumi paškontrolei: 
 

1. Vai obligāti jāpielieto Parent page kalendāra maketa izveidē? 
 
2. Vai nepieciešams aizslēgt slāni, ja tajā netiek veiktas darbības? 

 
3. Vai rindkopu stils jāizveido  visiem kalendāra dizainā izmantotajiem tekstiem? 

 
4. Vārda dienas teksta kastēs inportējam vai iekopējam? 

 
 
Uzdevums 5 

 
29.,30. mācību stunda 
 
1. Izveidot visu 12 mēnešu lapu salikumu 

 
 

Vērtēšana. 
 

Katra paveiktā darbība, izpildot uzdevumu, maksimāli dod 20 procentus. Nepaveikta darbība – 0 
procentus. Kopā, izpildot uzdevumu, maksimāli iespējams iegūt 100 procentus. 
Iespējami 5 uzdevuma darbību izpildes līmeņi. 
 

0.līmenis 
0 procenti 

1.līmenis. 
5 procenti 

2.līmenis. 
10 procenti 

3.līmenis. 
15 procenti 

4.līmenis. 
20 procenti 

Darbība 
nav 
paveikta. 

Darbība 
daļēji/nepilnīgi 
paveikta. 

Darbība 
paveikta, tomēr 
ir 
neprecizitātes 

Darbība precīzi 
paveikta. 
Audzēknis 
demonstrē izpratni 
par paveikto 

Darbība precīzi paveikta. 
Audzēknis demonstrē 
izpratni par paveikto. 
Analizē un pamato 
veiktās darbības. Zina un 
izprot paveikto darbību 
nozīmi un jēgu 
profesionālajā darba 
vidē. 

 

5.tabula. Uzdevuma vērtēšanas kitēriji 

 
 
Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu skalā, 
atbilstoši summatīvā vērtējuma izteikšanas tabulai Nr.9. 
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6. Kalendāra maketa izveide, izmantojot automatizāciju(script). 
 

 

Tēmas apjoms 6 mācību stundas  

Mērķis Apgūt iemaņas, kas paātrina kalendāra maketa izveides procesu. 

Uzdevumi Iepazīt un pielietot script.  

Sasniedzamais 
rezultāts 

Spēja izveidot kalendāra maketu ļoti ātri, izmantojot automatizāciju. 

Zināšanas Zina, kas ir scripti un kā tos pielietot. 

Prasmes Praktiski izmanto scriptus darba procesā. 
 

 
Apakštēmas 

31.,32.,33.,34. mācību stunda 

 
1. Scripta aktivizēšana 

Lejuplādējam kalendāra maketa izveides scriptu -  
https://calendarwizard.sourceforge.net/user-guide/user-guide-getting-started.html 
 
Aktivizējam to – 
https://helpx.adobe.com/indesign/using/scripting.html 
 
 
 

 
 
 
 
8.attēls.  Wizard script aktivizācija. 
 
 
 

https://calendarwizard.sourceforge.net/user-guide/user-guide-getting-started.html
https://helpx.adobe.com/indesign/using/scripting.html
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2. Veidojam kalendāra maketu, izmantojot Wizard scriptu. 
Sekojot instrukcijām, konstruējam kalendāra salikumu un ļaujam Wizard paveikt 
smagāko darba daļu. Izmantojot Wizard, makets tiek izveidots ļoti ātri un kvalitatīvi, bet 
salīdzinot ar manuāli paveiktu salikumu, tomēr cilvēka ieguldītās enerģijas sajūta uzvar 
un labprātāk dizaineri veido kalendāra salikuma maketus manuāli.  
 
 

 

 
 
 
 
 

9.attēls.  Wizard script pielietošana. 
 
 

 
Jautājumi paškontrolei: 
 

1. Kas ir scripti? 
 
2. Vai scriptu lietošana paātrina darba procesu? 

 
3. Vai scripta izmantošana ir maksas vai bezmaksas?  
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Uzdevums 6 

 
35.,36. mācību stunda 
 
1. Lejuplādēt un aktivizēt darbam scriptu Wizard.  

 
2. Izveidot kalendāra salikuma paraugu, izmantojot Wizard. 

 
 

Vērtēšana. 
 

Katra paveiktā darbība, izpildot uzdevumu, maksimāli dod 20 procentus. Nepaveikta darbība – 0 
procentus. Kopā, izpildot uzdevumu, maksimāli iespējams iegūt 100 procentus. 
Iespējami 5 uzdevuma darbību izpildes līmeņi. 
 

0.līmenis 
0 procenti 

1.līmenis. 
5 procenti 

2.līmenis. 
10 procenti 

3.līmenis. 
15 procenti 

4.līmenis. 
20 procenti 

Darbība 
nav 
paveikta. 

Darbība 
daļēji/nepilnīgi 
paveikta. 

Darbība 
paveikta, tomēr 
ir 
neprecizitātes 

Darbība precīzi 
paveikta. 
Audzēknis 
demonstrē izpratni 
par paveikto 

Darbība precīzi paveikta. 
Audzēknis demonstrē 
izpratni par paveikto. 
Analizē un pamato 
veiktās darbības. Zina un 
izprot paveikto darbību 
nozīmi un jēgu 
profesionālajā darba 
vidē. 

 

6.tabula. Uzdevuma vērtēšanas kitēriji 

 
 
Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu skalā, 
atbilstoši summatīvā vērtējuma izteikšanas tabulai Nr.9. 
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Gala pārbaudes darbs 
 

1. Izveidot grafikas dizaina skici kalendāram(kalendāra lapai) 
 

2. Izveidot kalendāra lapas funkcionālās daļas salikumu. 
 

3. Izveidot 12 mēnešu kalendāra salikumu, izmantojot WIZARD. 
 

 
 

Vērtēšana. 
 

Katra paveiktā darbība, izpildot uzdevumu, maksimāli dod 20 procentus. Nepaveikta darbība – 0 
procentus. Kopā, izpildot uzdevumu, maksimāli iespējams iegūt 100 procentus. 
Iespējami 5 uzdevuma darbību izpildes līmeņi. 
 

0.līmenis 
0 procenti 

1.līmenis. 
5 procenti 

2.līmenis. 
10 procenti 

3.līmenis. 
15 procenti 

4.līmenis. 
20 procenti 

Darbība 
nav 
paveikta. 

Darbība 
daļēji/nepilnīgi 
paveikta. 

Darbība 
paveikta, tomēr 
ir 
neprecizitātes 

Darbība precīzi 
paveikta. 
Audzēknis 
demonstrē izpratni 
par paveikto 

Darbība precīzi paveikta. 
Audzēknis demonstrē 
izpratni par paveikto. 
Analizē un pamato 
veiktās darbības. Zina un 
izprot paveikto darbību 
nozīmi un jēgu 
profesionālajā darba 
vidē. 

 

7.tabula. Uzdevuma vērtēšanas kitēriji 

 
 
Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu skalā, 
atbilstoši summatīvā vērtējuma izteikšanas tabulai Nr.9. 
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Vērtēšanas kritēriji un kārtība 

 
Ievērojot 2020.gada 2.jūnija Ministru kabineta noteikumus Nr.332 “Noteikumi par valsts 
profesionālās vidējās izglītības standartu un valsts arodizglītības standartu”, 
pamatiemaņu apguve darbā ar burtveidoliem digitālā vidē vērtējama: 
 
Apguves procesa laikā – summatīvi, katru no 6 plānotajiem paveiktajiem uzdevumiem 
(uzdevumu veido 5 jautājumi/darbības) vērtējot summatīvi, atbilstoši summatīvā vērtējuma 
izteikšanas tabulai Nr.9. 
Katra paveiktā darbība, izpildot uzdevumu, maksimāli dod 20 procentus. Nepaveikta darbība – 0 
procentus. Kopā, izpildot uzdevumu, maksimāli iespējams iegūt 100 procentus. 
Iespējami 5 uzdevuma darbību izpildes līmeņi. 
 

0.līmenis 
0 procenti 

1.līmenis. 
5 procenti 

2.līmenis. 
10 procenti 

3.līmenis. 
15 procenti 

4.līmenis. 
20 procenti 

Darbība 
nav 
paveikta. 

Darbība 
daļēji/nepilnīgi 
paveikta. 

Darbība 
paveikta, tomēr 
ir 
neprecizitātes 

Darbība precīzi 
paveikta. 
Audzēknis 
demonstrē izpratni 
par paveikto 

Darbība precīzi paveikta. 
Audzēknis demonstrē 
izpratni par paveikto. 
Analizē un pamato 
veiktās darbības. Zina un 
izprot paveikto darbību 
nozīmi un jēgu 
profesionālajā darba 
vidē. 

 

8.tabula. Uzdevuma vērtēšanas kitēriji 

 
 
Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu skalā, 
atbilstoši summatīvā vērtējuma izteikšanas tabulai Nr.9. 
 
Noslēdzot 36 h apguves procesu, jāveic pārbaudes darbs, kas sastāv no 5 veicamām darbībām.  
Katra pareizi paveikta darbība dod 20 procentus. Nepaveikta darbība – 0 punktus. Skatīt tabulu 
Nr.1. Saskaitot kopā iegūtos procentus, tiek izdarīts summatīvais vērtējums, kas izteikts 10 ballu 
skalā. 
 
Summatīvais vērtējums veidojas pārskatot un izvērtējot izpildītos 6 uzdevumus(uzdevuma 
izpilde atbilstoši prasītajiem noteikumiem), izvērtējot gala pārbaudījuma darbu, 
kā arī izvērtējot audzēkņa spēju atbildēt uz paškontroles jautājumiem, 
kas pievienoti katras apskatāmās tēmas noslēgumā. 
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Summatīvā vērtējuma izteikšana. 

 

Profesionālo 

kompetenču līmenis 

Nepietiekams kvalifikācijas 

ieguvei 
Pietiekams kvalifikācijas ieguvei 

zems1 vidējs2 optimāls3 augsts4 

Vērtējums ballēs 1 2 3 4 5 6 7 8 9 10 

Uzdevumu izpildes 

līmenis % 

1–14 15- 29 30–44 45–59 60–67 68–75 76–83 84–91 92–96 97–100 

S- Sācis apgūt T -  turpina 
apgūt A – apguvis P – apguvis 

padziļināti 

100 % 
 

9.tabula 

 
1 Zems apguves līmenis: vāji – 3, ļoti vāji – 2, ļoti, ļoti vāji – 1. 
2 Vidējs apguves līmenis: gandrīz viduvēji – 4; viduvēji – 5. 
3 Optimāls apguves līmenis: ļoti labi – 8, labi – 7, gandrīz labi – 6. 
4 Augsts apguves līmenis: izcili – 10, teicami – 9. 
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Noslēgumā 
 
Veiksmīgi pabeidzot pamatiemaņu apguvi « Kalendāra maketa izveide, izmantojot Adobe 
InDesign», ir jāturpina pielietot un nostiprināt jauniegūtās iemaņas. 
 
Regulāri jāturpina veidot kalendāru grafikas dizains un salikumi,  
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Mācību procesā izmantojamie avoti 
 

Kristina Nickel. Ready to Print: Handbook for Media Designers 
 
Rob Carter. Working with Computer type 3 Color&Type. Roto Vision SA. 1997. 
 
Rob Carter. Working with Computer type 1 Books Magazines Newsletters. Roto Vision SA. 
1995. 
 
Beth Tondreau. “Layout Essentials.  
100 DESIGN PRINCIPLES FOR USING GRIDS”, 2009 by Rockport Publishers, Inc. 
 
https://helpx.adobe.com/indesign/user-guide.html 
 
https://creativepro.com/ 

Visual Design. Ninety-five things you need to know. Told in Helvetica and dingbats. Jim 
Krause. New Riders. 2015 

REAL WORLD PRINT PRODUCTION WITH ADOBE CREATIVE CLOUD Claudia McCue.  
Peachpit. 2014   

Charlotte&Peter Fiell. Contemporary Graphic Design. Taschen. 2007. 
 
Timothy Samara. Typography Workbook. Rockport publishers. 2004. 
 
Ivan Vantanian. Typographics. RotoVision SA, 2003. 
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